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Introduction

This document provides information you need to install
Unified Communication Center (UCC) Release 1.0 software
from the product CD onto the UCC base server. You can
install Avaya Web Messaging or Avaya Web Collaboration
or both.

Note: Avaya Advanced Speech Access software is installed on a
separate media (speech) server by using other CDs. Its
installation procedure is documented in the Avaya Advanced
Speech Access for UCC Installation Guide.

This guide to base server installation contains the
following topics:

Topic Description

Introduction on page 1 Explains the basic architecture of the UCC base server
and associated separate products.

Prerequisites on page 4 Explains prerequisites for the base server, other
servers, and the PBX to prepare for installation of UCC.

Installation on page 13 Provides step-by-step installation procedures.

Worksheets on page 43 Provides a place to write the values of various server
and PBX parameters.

UCC Glossary on page 47 | Defines UCC-related terms used in this document.

Release 1.1 585-313-161 1
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UCC Base Server Installation Guide

Product Architecture

This topic provides a brief introduction to the Unified
Communication Center (UCC) architecture.

Either or both Avaya Web Messaging and Avaya Web
Collaboration can be installed on the UCC base server,
along with other required applications that are installed
automatically from the UCC CD. pcAnywhere, virus
protection software, and CVCT (described below) are the
only other applications allowed on the base server.

The UCC base server operates in conjunction with one or
more DEFINITY or IP600 PBX’s and the following separate
servers and software whose installation is described in
documentation associated with the products (see also the
figure after this list):

4

m  One optional UCC “"media server” or “speech server”
that runs Advanced Speech Access (ASA) software.
The speech server can be installed before or after
the base server is installed. The speech server uses
separate CDs and a separate installation guide from
those of the base server.

m Microsoft Exchange Server, used by Avaya Web
Messaging (and ASA).

m Up to eight Octel 250/350 (Aria), Octel 200/300
(Serenade), INTUITY AUDIX, or INTUITY LX voice
message servers in any combination if ASA is
installed (up to 50 message servers if only the UCC
base server is installed).

m  OctelAccess Servers (OAS) are required for Aria and
Serenade message servers. (Up to eight OAS boxes
are supported; however, a single OAS box can
support up to eight Aria and Serenade message
servers.)

m  CentreVu Computer Telephony (CVCT) software on
the base server or a separate server, if Avaya Web
Collaboration is to be installed.

See Prerequisites on page 4 for specific software release
(version) requirements.

Release 1.1 585-313-161 2
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Prerequisites

Note: Throughout the Prerequisites and Installation topics, use
the Worksheets on page 43 topic to document important
parameter values in one place.

This topic describes at a high level the prerequisites that
must be met before you can install the UCC base server
software from the UCC product CD.

Note: As the installer, you must have an administrative login
account and password for the UCC base server and working
knowledge of Windows 2000 Server administration. You can
record this information in item 1 of the Worksheets Base Server
Data on page 43.

UCC Base Server Hardware Prerequisites

Verify that the UCC base server meets the following PC
hardware requirements:

m 1 GHz Pentium III or equivalent processor.
m 1 GB RAM.

m 20 GB of available space (NTFS format) on the hard
drive, regardless of which software components you
plan to install. (Only 350 MB are required for the
software alone, but 20 GB are required for correct
operation of the software in the customer
environment.)

m Modem.

Release 1.1
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Prerequisites

m CD-ROM drive.

3.5" diskette drive to install CVCT software, which is
required for Avaya Web Collaboration, on the base
server (unless CVCT is installed or will be installed
on its own separate server).

m Network Interface Cards (NICs):

m A NIC is required in the base server to connect

to the corporate LAN.

If UCC is to be used with a single PBX, Avaya
strongly recommends using a separate NIC to
connect to the PBX as a private connection;
install this NIC wherever CVCT software is
installed or will be installed (in the base server
or a separate T-server).

However, if multiple PBXs are to be connected to
CVCT, the PBXs should be on the corporate LAN,
not on a private LAN segment; for this
configuration, if CVCT is to be installed on the
base server, a separate NIC for CVCT is not
recommended.

In addition, if the customer requires a DMZ
configuration for wireless access, another NIC is
required in the base server for internet access.

Before you install the UCC software, the base server
hardware must be installed on the network at the
customer site.

UCC Base Server Software Prerequisites

Verify that the following software is installed on the UCC
base server:

m  Windows 2000 Server, including:

m Windows 2000 Server Service Pack 2

IIS 5.0

Internet Explorer 5.5 with its Service Pack 2

Release 1.1
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Prerequisites

m pcAnywhere version 10 or later

m Virus protection software with the latest updates
(recommended)

Caution: Do not use Windows 2000 Advanced Server.
Caution: Do not use Terminal Services during this installation.

Caution: Avaya strongly recommends that you save an image
of the base server with its network settings and the required
Windows operating system, service packs, and other software as
described above, before you begin installing CVCT or UCC
software on the base server. Then, if it becomes necessary, you
can quickly restore the server to its initial configuration.

UCC Base Server Information Prerequisites

As previously stated, you must have administrative
privileges for the UCC base server and working knowledge
of Windows 2000 Server administration.

Obtain and record data from the base server as described
in the following steps. If any of the data has not been
configured yet, record the data that is available and use
the procedures later in this section to specify other data.

1. In Windows 2000, click Start and then Run.
2. Type cmd and press Enter.

3. In the cmd.exe window, type ipconfig /all and
press Enter.

4. In items 2 and 3 of the Worksheets Base Server
Data on page 43, write the (static) IP Address and
the preferred DNS server address of the NIC that
connects to the corporate LAN.

5. Write the Host name (Full computer name and the
Domain) in item 4 of the Worksheets Base Server
Data on page 43.

6. Write the value of the Primary DNS suffix of this
computer in item 5 of the Worksheets Base Server
Data on page 43.

7. Write the first Physical Address listed (in the format
XX-XX-XX-XX-XX-XX) in item 6 of the Worksheets
Base Server Data on page 43.

Release 1.1
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Prerequisites

8.

Write the Default Gateway value (an IP address) in
item 7 of the Worksheets Base Server Data on page
43.

If the fully qualified domain alias nhame for the base server
is to be specified during installation to help keep the
server’'s URL anonymous, obtain the alias from the DNS
administrator and write it in item 8 of the Worksheets
Base Server Data on page 43.

If necessary, specify the base server’s static IP address
and preferred DNS server address:

1.

5.

In the Windows 2000 desktop, right-click My
Network Places and click Properties.

Right-click Local Area Connection and click
Properties.

On the General tab, double-click Internet Protocol
(TCP/IP).

Specify the IP Address and Preferred DNS Server of
the NIC that connects to the corporate LAN and
write the values in items 2 and 3 of the Worksheets
Base Server Data on page 43.

Click OK until all dialog boxes are closed.

If necessary, specify the Primary DNS suffix:

1.

In Windows 2000, select Start > Settings >
Control Panel > System.

Select the Network Identification tab.
Click the Properties button.

Click the More... button on the Identification
Changes screen.

Work with the customer to specify the value of the
Primary DNS suffix of this computer and write it in
item 5 of the Worksheets Base Server Data on page
43.

For your changes to be accepted, click OK until the
Control Panel windows are closed.

Release 1.1
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Prerequisites

Prerequisites Unique to Avaya Web

Messaging

If you plan to install Avaya Web Messaging as part of the
UCC installation, verify that these servers are running
correctly:

OctelAccess Server (OAS), Release 3.0, if any Octel
Aria or Serenade message servers are configured

LAN connectivity between the clients, the UCC base
server, and the message servers

Prerequisites Unique to Avaya Web

Collaboration

If you plan to install Avaya Web Collaboration as part of
the UCC installation:

Create an administrative account with password
protection on the base server for use with CVCT. (If
CVCT is already installed on the base server, obtain
the account login and password for CVCT.) This
account on the base server is needed for CVCT,
whether CVCT is installed on the base server (that
is, coresident with UCC) or on a separate server.
Write the account and password values in item 9 of
the Worksheets Base Server Data on page 43.

Ask the customer whether an external LDAP
directory is to be used and, if so, write its LDAP
URL, Popular Name, and Search Base in item 10 of
the Worksheets Base Server Data on page 43.

If the customer plans to use SSL for Avaya Web
Collaboration, verify that the Secure Socket Layer
(SSL) certificate is already installed. Obtain the
directory path to it and write the path in item 11 of
the Worksheets Base Server Data on page 43.

If the customer is using an alias for the base server
as previously described, the SSL certificate must be
installed (reinstalled, if necessary) using the name
of the alias (item 8 of the Worksheets Base Server
Data on page 43), not the actual machine name.

Release 1.1
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Prerequisites

If the customer is not using an alias for the base
server, use the fully qualified DNS name (item 4 of
the Worksheets Base Server Data on page 43).

CVCT Prerequisites Unique to Avaya Web Collaboration

Verify that the following CVCT prerequisites to installing
Avaya Web Collaboration are met:

m Avaya CentreVu Computer Telephony (CVCT)

version 9.5 (or later) active telephony server
software must be installed on the base server or a
separate T-server (by using the instructions
provided with CVCT).

See UCC Base Server Hardware Prerequisites on
page 4 for NIC requirements.

Contact the PBX administrator to determine
whether CVCT has been installed. If not, install it on
the base server or a separate server before
installing UCC.

Caution: When installing CVCT, at the Server Setup
dialog box, clear (uncheck) the Telephony Services
Security Data Base check box. Select only the Telephony
Server for Windows and the DEFINITY G3 PBX Driver and
CallVisor PC check boxes.

Make sure that CVCT has been successfully installed
and tested and is handling calls correctly for each
PBX to be used with UCC. See the appropriate CVCT
installation documentation.

For a configuration using a single PBX, check the
properties of the NIC associated with CVCT and
connected to the PBX (in the base server or a
separate T-server) to make sure that this NIC is set
to operate at 10 MBps.

Caution: For a configuration using multiple PBXs, CVCT
on the base server, and a single NIC in the base server,
do not change that NIC’s setting.

If CVCT is installed on a T-server separate from the
UCC base server, obtain the host name and the IP
address of the NIC in the CVCT server connected to
the PBX and write them in items 19 and 20 of the
Worksheets CVCT Data (Obtain Before Installing
UCC) on page 45.

Release 1.1
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Prerequisites

m If CVCT is installed coresident with UCC on the base
server, obtain the IP address of the NIC in the
server connected to the PBX and write it in item 21
of the Worksheets CVCT Data (Obtain Before
Installing UCC) on page 45. (You already wrote the
host name for the base server in item 4.)

PBX Prerequisites Unique to Avaya Web Collaboration

For each PBX, verify that the following prerequisites to
installing Avaya Web Collaboration are met:

m  An adjunct link station must be administered on the
PBX; the capability must have already been enabled
when CVCT was purchased.

m  Work with the PBX administrator to reserve a block
(range) of Administered Without Hardware (AWOH)
numbers. Write this range in item 16 in the
Worksheets PBX Data (Obtain Before Installing
UCC) on page 45. If UCC will use multiple PBXs,
make a separate entry for each PBX.

Create (assign) AWOH extensions for each person
who will be a remote user of Avaya Web
Collaboration. Add a station of type CTI with the
port set to X and the Class of Service and Class of
Restriction set to the same values as for that user’s
primary extension.

m  When using a single DEFINITY PBX, ask the PBX
technician to dial in or telnet to the MAP-D board to
determine its IP address. By default, the value is
192.168.25.10 if the MAP-D board is connected to a
private LAN segment, as is recommended.

When using a single IP600 PBX, use the PBX
console to determine the IP address of the C-LAN
board or processor board.

If multiple PBXs are to be connected to CVCT, they
should be on the corporate LAN, and you need to
assign IP addresses as provided by the customer to
each of them.

Write the IP address and the PBX software release
in items 17 and 18 of the Worksheets PBX Data
(Obtain Before Installing UCC) on page 45. If UCC
will use multiple PBXs, make separate entries for
each PBX.

Release 1.1 585-313-161 10
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Prerequisites

Voice Message Server Prerequisites

For INTUITY AUDIX voice message servers, IMAPI must
have been purchased and enabled.

For Octel Aria and Serenade voice message servers, client
access licenses must have been purchased and enabled,
and the message servers must be connected to
OctelAccess Servers at Release 3 (see Product
Architecture on page 2).

The following table describes minimum software
requirements.

Message Server Type | Minimum Software Release
INTUITY AUDIX 5.1
INTUITY AUDIX LX 1.0
Octel Aria 3.1
Octel Serenade 4.1

PBX Prerequisites

Verify that the following prerequisites are met for each
PBX to be used with UCC:

m The software release is G3V8 (load release 49 or
later) or G3V9 (load release 33 or later).

m If a DEFINITY PBX is used:
m A registered MAP-D board is installed.

m The PBX name must have only alphanumeric
characters. If you must change the name, take
into account the effect on associated devices.

m PBX administration has been completed as
required for the customer’s DEFINITY release.
See the appropriate DEFINITY system
administration documentation.

m Media stations are set up as required for VoIP (IP
SoftPhone) users.

Release 1.1
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Prerequisites

m If an IP600 PBX is used, a C-LAN board is installed.

m  One Xmobile station is configured for each user of
Avaya EC500 Extension to Cellular.

Prerequisite Testing

From the base server, ping the default gateway and DNS
servers:

1. In Windows 2000, click Start and then Run.
2. Type cmd and press Enter.

3. In the cmd.exe window, type ping <IP address>.
Use the default gateway’s IP address (as previously
noted in item 7 of Worksheets Base Server Data on
page 43). Press Enter.

4. Repeat these steps to ping the preferred DNS
server’s IP address (as previously noted in item 3 of
Worksheets Base Server Data on page 43).

Ensure that someone such as the PBX technician will be
available to describe the dialing plan to you when you
install UCC.

Release 1.1 585-313-161 12
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Installation

Overview

Note: If you need to install CVCT software on the base server
for use with Avaya Web Collaboration, install CVCT now. See
CVCT Prerequisites Unigue to Avaya Web Collaboration on

page 9.

By default, the base server software installation process
installs both Avaya Web Messaging and Avaya Web
Collaboration software components. However, you can
install only one of the components, if the customer wants
only one. After you specify which components to install,
software is installed in the following sequence:

1.

Java Runtime Environment (JRE) 1.3.1. This
software is required for UCC to work correctly in the
operating system environment.

Tomcat and its configuration with IIS. This software
is required for UCC to work correctly in the
operating system environment.

Avaya WebLM (license manager). This software
manages UCC licenses.

Microsoft Posting Acceptor, if it is not already
installed and if Avaya Web Messaging is selected for
installation.

Avaya Web Messaging, if selected for installation.

Release 1.1
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Installation

6. iPlanet Directory Server, if Avaya Web Collaboration
is selected for installation.

7. Avaya Web Collaboration, if selected for installation.

Installation of items 1-4 above occurs quickly and
automatically, without any interaction between you and
the installation process. After you complete the entire
installation procedure, you must verify correct installation,
as described in this topic.

Installation Procedure for UCC Base Server

Begin the installation:

1. If you plan to install Avaya Web Collaboration, you
must shut down SNMP services and any associated
server monitoring agents now.

2. If the customer plans to use Secure Socket Layer
(SSL) security for Avaya Web Collaboration, the SSL
certificate must have already been installed on the
base server.

3. You might want to disable virus protection software
during the installation.

4. Insert the product CD and click INSTALL UCC on
the screen that automatically appears or browse to
the Autorun.exe file on the CD and click it. If you
previously chose a different option when you
inserted the CD, you can begin installation by
reinserting the CD and selecting INSTALL UCC.

The rest of the installation process is described below in a
table format, where each row relates to a particular dialog
box you see as installation progresses. The information in
a row describes how to complete the fields in that dialog
box and then proceed to the next dialog box. There are
separate tables for initial UCC base server installation
setup and for installation of Avaya Web Messaging, iPlanet
Directory Server, and Avaya Web Collaboration.

Use the following table to complete the InstallShield
screens for copying UCC software from the CD to the
server:

Release 1.1
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Installation

Dialog Box Title

Required Actions

Notes

InstallShield Wizard

Wait for the UCC setup
to be completed.

Avaya Unified
Communication Center
— InstallShield Wizard
(Welcome screen)

Click Next.

Avaya Unified
Communication Center
— InstallShield Wizard
(License Agreement)

Read the license
agreement and click the
I accept the terms in
the license agreement
radio button. Then click
Next.

Release 1.1
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Installation

Dialog Box Title

Required Actions

Notes

Avaya Unified
Communication Center
— InstallShield Wizard
(Information)

If an alias is to be used
for the base server,
enter the alias that you
obtained from the
domain name server
administrator and wrote
in item 8 in the

Worksheets Base Server

Data on page 43.

If an SSL certificate is
installed on the base
server, enter the
absolute path to file
name as noted in item
11 of the Worksheets
Base Server Data on
page 43. Use the
Browse button if
necessary to find the
certificate.

Indicate whether SSL is
enabled for the ASA
server.

If you have already
installed or plan to
install an Advanced
Speech Access server
and if you know its fully
qualified domain name,
enter it in the Avaya ASA
Server Name field. Write
this value in item 22 in
the Worksheets
Advanced Speech Access

(ASA) Server Data on
page 46. If you do not
know the ASA server
name, you do not need
to indicate whether SSL
is enabled for ASA.

Click Next.

Establishing an alias for
the base server helps
keep its URL
anonymous.

Release 1.1
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Installation

Dialog Box Title

Required Actions

Notes

Avaya Unified
Communication Center
— InstallShield Wizard
(Destination Folder)

You may either accept
the default destination
folder on the C: drive, or
change the drive where
you would like the UCC
Base Server installed
(D:, etc.). Note that
none of the folder names
on the path to the
destination directory can
have any spaces.

Click Next.

Avaya Unified
Communication Center
— InstallShield Wizard
(Setup)

By default, both Avaya
Web Messaging and
Avaya Web Collaboration
will be installed.

To disable installation of
either software
component, click the
down arrow to the left of
that component’s name
and click X This feature
will not be installed. A
red X appears beside
that component to
indicate that it will not
be installed.

Click Next.

The Help button, if
present, provides Help
only for InstallShield
Setup, not for the UCC
installation process.

Avaya Unified
Communication Center
— InstallShield Wizard
(Ready to Install the
Program)

Click Install to begin
copying the files for the
software components
from the CD to the
server.

When copying is
complete and the Next
button becomes
available, click it.

JRE 1.3.1, Tomcat, and
Avaya WebLM get
installed automatically.

If you chose not to install Avaya Web Messaging, skip to

the topic titled iPlanet Directory Server on page 19.

Release 1.1

585-313-161
Release 1.1

17



Installation

Avaya Web Messaging

If you chose to install Avaya Web Messaging, now that its
files have been copied to the server, its installation as
functional software begins.

Dialog Box Title

Required Actions

Notes

Read Me file Click Continue.

Avaya Web Click Next.

Messaging (TM)

Installation

(Welcome screen)

Avaya Web After you review the topics of You can view

Messaging (TM)
Installation (Tell Me
About screen)

interest, click Next in the body
of the screen and then select
Continue With Install.

Click Next at the bottom of the
dialog box.

information about the
training and the
documentation, or
you can continue the
installation.

Avaya Web
Messaging (TM)
Installation (Backup
Replaced Files?
screen)

Select Yes and click Next.

You must back up all
Windows system files
that are replaced
during installation.

Select Program
Manager Group

Leave the default as is and click
Next.

Avaya Web
Messaging (TM)
Installation (Select
Virtual Directory
screen)

Enter the virtual directory
name to use. Click Next.

A virtual directory will
be created. Users
access Avaya Web
Messaging by using
this virtual directory
name.

If you want, use the
default, webmsg.

Avaya Web
Messaging (TM)
Installation (Ready
to Install screen)

Click Next.

Release 1.1
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Installation

Dialog Box Title Required Actions Notes

Installing Wait for the next dialog box to | Microsoft Posting
appear. Acceptor gets
Caution: If you see any messages 'nSta”ed_ if it is not
asking whether you want to overwrite | already installed.
newer files, never overwrite newer
files.

Avaya Web Click Finish.

Messaging (TM)

Installation

(Installation

Completed!)

If you are not installing Avaya Web Collaboration now, skip
to the topic titled Server Reboot on page 27.

iPlanet Directory Server

If you chose to install Avaya Web Collaboration, iPlanet
Directory Server software must be installed first. The

iPlanet Directory Server files were copied to the server,
and now their installation as functional software begins.

Caution: Do not use previously installed iPlanet
Directory Server software. Installation will stop if you try

to do so.

Use the following table to complete iPlanet Directory
Server installation:

Dialog Box Title

Required Actions

Notes

Welcome

Read this screen and
click Next.

Software License
Agreement

Read the license
agreement and click
Yes.

Select Server or Console
Installation

Select the iPlanet
Servers radio button
and click Next.

Type of Installation

Select the Typical radio
button and click Next.

Release 1.1
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Installation

Dialog Box Title

Required Actions

Notes

Location of Installation

Accept the default
destination folder on the
C: drive. Do not change
this value. (None of the
folder names on the
path to the destination
directory can have any
spaces.)

Then click Next.

Components to Install

Accept all defaults and
click Next.

SNMP Is Running
(see Notes column)

Click OK.

This dialog box will
appear only if you did
not shut down SNMP as
directed prior to
installation.

Directory Server 5.0
(with “"Configuration
Directory Server”
options).

Accept the default radio
button selection This
instance will be the
configuration
directory server and
click Next.

Directory Server 5.0
(with “Directory to store
data” options).

Accept the default radio
button selection Store
data in this directory
server and click Next.

Directory Server 5.0
Server Settings

Accept the default
values for all fields on
this screen (the Server
Port is 389).

Click Next.

Release 1.1
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Installation

Dialog Box Title

Required Actions

Notes

Directory Server 5.0
iPlanet configuration
directory server
administrator

Accept the default
Configuration
Directory
Administrator ID value
of admin.

Enter and re-enter a
password for the iPlanet
directory server
administrator and write
it in item 12 of the

Worksheets Base Server

Data on page 43.
Then click Next.

This step creates an
iPlanet account, not a
Windows 2000 account.

Directory Server 5.0
Administration Domain

Accept the default
Administration
Domain and click Next.

Directory Server 5.0
Directory Manager
Settings

Enter and re-enter a
password of at least
eight characters for the
Directory Manager and
write it in item 13 of the

Worksheets Base Server

Data on page 43.
Then click Next.

This password can be
the same as or different
from the password you
just created for the
directory server
administrator. The
password is used to
display the LDAP
directory using iPlanet
directly. The UCC
administrator will use
this password to
administer Avaya Web
Collaboration from its
Web page.

Administration Server
Port Selection

Accept the default value
and click Next.

It can take a few
seconds for the next
(Configuration
Summary) dialog box to
appear.

Configuration Summary | Click Install. It can take a few
seconds for the next
(Installation Progress...)
dialog box to appear.
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Dialog Box Title

Required Actions

Notes

Installation Progress...

Wait for the next dialog
box to appear.

Completion of
Installation

Important:

Select the No, I will
restart my computer
later radio button and
click Finish.

Avaya Web Collaboration

If you chose to install Avaya Web Collaboration, now that
its files have been copied to the server (and iPlanet
Directory Server has been installed), installation of Avaya
Web Collaboration as functional software begins.

Dialog Box Title

Required Actions

Notes

Setup

None

Avaya Web Collaboration
Setup

Click 1) Install Avaya
Web Collaboration.

This first of two major
steps in the Avaya Web
Collaboration Setup
allows you to install the
Avaya Web Collaboration
software.

You must complete the
steps in the order
shown, as described in

detail below.
popup: Install Script is None
unzipping the Avaya
Web Collaboration files.
Please be patient.
Setup None Wait for the copying of

files to be completed.

Information

(Avaya Web
Collaboration: Install
Avaya Web Collaboration
option completed.)

Read the message and
click OK.

This confirms that all the
files were copied to the
target PC.
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Dialog Box Title

Required Actions

Notes

Avaya Web Collaboration
Setup

Click 2) Configure
Avaya Web
Collaboration.

This second of the two
major steps in the Avaya
Web Collaboration Setup
configures the directory
services, that is, it
configures the files that
were copied in the
previous steps, and it
allows you to configure
Avaya Web
Collaboration.

Location

Enter a location or
department within the
organization that this
application will serve, for
example, Denver or
Accounting. Then click
Next.

Avaya Web Collaboration
Server

(This screen is displayed
only if the Avaya Web
Collaboration installation
process cannot find the
server’s host name in
the registry.)

If necessary, enter the
Avaya Web Collaboration
HostName for the base
server (the full computer
name and domain as
entered in item 4 of the

Worksheets Base Server

Data on page 43), and

click Next.

This name will be used
by other machines to
contact the Avaya Web
Collaboration Server,
that is, the base server.
The host name of the
base server must be
registered with the DNS.
This information is
common to all machines
in the domain.

Avaya Web Collaboration
Server IP Address

(This screen is displayed
only if the Avaya Web
Collaboration installation
process cannot find the
IP address in the
registry.)

If necessary, enter the
IP address of the Avaya
Web Collaboration
Server (item 2 of the

Worksheets Base Server

Data on page 43) and

click Next.

The Avaya Web
Collaboration Server
must have the static IP
address of the base
server.

Telephony Server Name

(This screen is displayed
only if the Avaya Web
Collaboration installation
needs to locate a
separate Telephony
Server box.)

Enter the Telephony
Server Host name from
item 19 of the
Worksheets CVCT Data
(Obtain Before Installing

UCC) on page 45. Click

Next.

The Telephony Server
Host name must be
registered with the DNS.
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Dialog Box Title

Required Actions

Notes

Avaya Web Collaboration
Telephony Links

Confirm the TLINKs
associated with the
Avaya Web Collaboration
Server and click OK.

After you complete the
installation, you can
delete the unwanted
TLINKs by accessing
Avaya Web Collaboration
Associations in the
administration screens.

Telephony Server Login

Enter the login and
password for the
Telephony Server
administrator from item
9 of the Worksheets
Base Server Data on
page 43. Enter the
password again to
confirm it and click
Next.

These actions will allow
the Avaya Web
Collaboration Server to
communicate with the
Telephony Servers.
Since each Telephony
Server has its own login
and password, you must
enter the login and
password for each
Telephony Server.

Add Another Telephony
Server?

If you want to add
another Telephony
Server, click Yes and
return to the Telephony
Server Name dialog box
as described several
rows ago in this table.

If you have finished
adding Telephony
Servers, click No.

Email Information

(Seen if you selected No
on the previous screen)

Enter the organization’s
e-mail suffix, for
example, @avaya.com.

Then click Next.

When the administrator
enters the users’ e-mail
information in the
Directory Server, this
suffix will be appended
to each user ID.
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Dialog Box Title

Required Actions

Notes

LDAP Information

Enter the customer’s
LDAP URL, Popular
Name, and Search
Base. See item 10 of
the Worksheets Base
Server Data on page 43.

Click Next.

If you are not sure about
this information, click
Skip (and proceed to
the Information screen
several rows later in this
document). The
administrator can add
this LDAP information
later, using Avaya Web
Collaboration
administration.

The Avaya Web
Collaboration Server
allows users to carry out
LDAP queries on their
corporate directory. For
example, a search for
someone with the first
name of John will list the
first 100 entries for John
from the corporate
directory.

The LDAP URL must be
the URL where the
organization directory
accesses the LDAP
interface.

The Popular Name can
be any familiar name
given to the corporate
directory, for example,
POST.

Enter the Search Base
in the general format of
o=company name,
c=country, ou=people.
For example, o=avaya,
c=UsS.

Avaya Web Collaboration
Setup

If you would like to add
another LDAP directory,
click Yes and return to
the LDAP Information
dialog box as described
above.

If you finished adding
LDAP directories, click
No.

LDAP Information

(Seen if you selected No
on the previous screen)

Click Next.

This list summarizes the
LDAP directories you
added.
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Dialog Box Title

Required Actions

Notes

Avaya Web Collaboration
Server

(This screen is displayed
only if the Avaya Web
Collaboration installation
process cannot find the
server’s host name in
the registry.)

If necessary, enter the
Avaya Web Collaboration
HostName for the base
server (the full computer
name and domain as
entered in item 4 of the

Worksheets Base Server

Data on page 43), and
click Next.

Avaya Web Collaboration
Server IP Address

(This screen is displayed
only if the Avaya Web
Collaboration installation
process cannot find the
IP address in the
registry.)

If necessary, enter the
IP address of the Avaya
Web Collaboration
Server (item 2 of the

Worksheets Base Server

Data on page 43) and
click Next.

The Avaya Web
Collaboration Server
must have the static IP
address of the base
server.

Installation continues for
about one minute before
the next dialog box
appears.

Information

Read the message and
click OK.

Notepad will be launched
for you to enter the
support contact
information.

support-contact —
Notepad

Edit the file to identify
where end users are
sent when they click the
Technical Support link to
contact their local UCC
system administrator for
assistance. Select File >
Save to save the
changes. Select File >
Exit to close the file.

Information Click OK.
(Avaya Web
Collaboration: Configure
Avaya Web Collaboration
option completed)
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Dialog Box Title Required Actions Notes

Avaya Unified Click Finish. This screen might be
Communication Center hidden behind other
— InstallShield Wizard windows. Avaya Web

(InstallShield Wizard
Completed)

Collaboration is now
configured.

Avaya Unified
Communication Center machine.
Installer Information

Click Yes to reboot the

Server Reboot

Reboot the server if you have not already done so.

License File Installation

Before you began the UCC installation process, the
customer must have received a license file called Unified
Communication Center and must have saved it where the
instructions that came with it specify.

The license file is needed to activate the UCC software and
to add users. It identifies which UCC applications the
customer has purchased and it controls access to the
applications.

As part of the installation process, the UCC license server
was installed on the UCC base server. The license server
obtains license data from the license file each time UCC
starts up. To install the license file:

1. Log in as the base server administrator.

2. In Windows 2000, select Start > Programs >
Avaya UCC Administration.

The Unified Communication Center Administration
page is displayed.

3. Click the Avaya™ License Manager link. The
Avaya™ License Manager main page (WebLM) is
displayed, showing which applications are licensed.
However, no licensed products are displayed here
until you complete this procedure to install the
license file.
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10.

11.

12.

13.

The Host ID number is also displayed on this page.
The customer will need to provide the Host ID
number when requesting license files in the future.
Write it in item 14 of the Worksheets Base Server
Data on page 43.

Click the License Administration link to go to the
Login page.

The WebLM Administrator Login page is displayed.

On the Login page, the User name is displayed as
admin. You do not have to enter a password on this

page.
Click Continue.
The Select a New Password page is displayed.

Type a new password in the text box called New
password.

To confirm the new password, type it again in the
text box called Re-type new password. Write the
license manager administrator password in item 15
of the Worksheets Base Server Data on page 43.

Click Continue.

Close the window that says "Password has been
changed."

Click the License Manager link and then click the
License Admin link.

Enter the password and click Continue.
The License Administration page is displayed.

In the License Administration page under Install
License File, click Browse to locate the Unified
Communication Controller file (or specify the file if
you know the path).

Click Install to upload the file to the WebLM server,
which installs the license file. Once the license file is
installed, you can add users by clicking the Avaya™
UCC User link on the Unified Communication Center
Administration page.
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14. To verify correct installation of the license file, view
it by selecting Start > Programs > Avaya UCC
Administration, clicking the Avaya License
Manager link, and clicking the Unified
Communication Center link.

Installation Verification

In this topic, you verify correct operation of the software
components you installed on the base server.

Initial Verification

As a basic verification of installation, access the UCC
administrator’'s Web pages for the applications you
installed—Avaya Web Messaging or Avaya Web
Collaboration or both. In Windows 2000, select Start >
Programs > Avaya UCC Administration and select
Avaya Web Messaging or Avaya Web Collaboration.

If you cannot access one or more of these Web pages,
make sure that the Tomcat service and the World Wide
Web Publishing Service are running. Right click My
Computer, click Manage, expand Services and
Applications, and click Services.

If you did not install Avaya Web Messaging, skip to the
subtopic titled Verify the Avaya Web Collaboration
Installation on page 38.

Verify the Avaya Web Messaging Installation

When you installed Avaya Web Messaging, all the
components needed to run, configure, and monitor the
use of Avaya Web Messaging were installed, including:

m Avaya Web Messaging

m Avaya Web Messaging Administration and
Maintenance tools

m Avaya Web Messaging Tools program group
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Identify the
Message Servers
and Retrieve
Their Names
Directories

Before Avaya Web Messaging can be used, you must work
with the Avaya Web Messaging system administrator and
complete the following tasks, as described in detail in
subsequent subtopics:

1.

Identify the message servers and retrieve the
Names Directory for each message server by using
the Avaya Web Messaging administration pages.

Optionally, configure an INTUITY AUDIX message
server as a trusted server for alarming information
so that if an error is found during the periodic
check, an alarm condition is set on the message
server. For instructions on setting up trusted server
alarming, see the Help topic, Configuring a
trusted server, that is accessible within the Avaya
Web Messaging Administrator screens.

Configure Avaya Web Messaging parameters by
using the Avaya Web Messaging Server Options and
Settings page.

Run the Install Verify Tool.
Restart Tomcat.

Add a user to Avaya Web Messaging as described in
the UCC Administration Guide.

Work with the system administrator to identify and
configure message servers:

1.

In Windows 2000, select Start > Programs >
Avaya UCC Administration and select Avaya
Web Messaging.

The Administration logon page appears.

In the Log On box, type admin. Enter the default
password, adminl.

Click Log On.
The Administration and Maintenance page appears.

Select Message Servers from the Administration
list.

A blank Administration: Message Servers table
appears.

In the Message Server or OAS Name (or IP
Address): box, enter:

Release 1.1

585-313-161 30
Release 1.1



Installation

m For INTUITY AUDIX message servers, the
message server name or IP address.

m For Octel Aria and Serenade message servers,
the specific gateway name. For example, if the
Aria or Serenade gateway name is "messages"
and the OctelAccess server name is "OASname"
enter messages@OASname. You can enter the
OctelAccess server name portion as an IP
address, but you cannot enter the Aria or
Serenade gateway name portion as an IP
address. (If there is only one Aria or Serenade
on the OctelAccess server, you can enter only
the OctelAccess server name in this field.)

Connectivity between the UCC base server and the
specified message server will be verified.

6. Click Add.

A page appears that allows you to administer the
message server directory download.

Note: If you do not download a message server’'s Names
Directory to the UCC base server, UCC users will not be able to
look up names of messaging (voicemail) subscribers on that
message server.

7. For Octel (Aria or Serenade) message servers and
their associated OctelAccess Servers, enter the
Names Directory Retrieval schedule for the base
server to use (5:00 a.m. by default). Schedule the
base server’s Names Directory retrieval to occur at
least one hour after OctelAccess retrieves the
Names Directory from the Octel message server
(4:00 a.m. by default).

Each INTUITY AUDIX message server must have a
mailbox dedicated to retrieval of its Names
Directory. This mailbox must have a valid password
and permissions set to allow IMAPI access and
IMAPI message transfer. If such a mailbox is not
configured, create one now. At the base server,
enter the following Names Directory information:

m The AUDIX mailbox number that will be used to
retrieve the Names Directory

m The password for this mailbox
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10.

m The Names Directory retrieval schedule

Also, you can optionally set up a trusted server
relationship between INTUITY AUDIX message
servers and the UCC base server. Then, if an error is
found during the periodic communications check
that is initiated by the base server, an alarm
condition is set on the INTUITY AUDIX message
server. Set up a trusted server relationship first at
the INTUITY AUDIX message server and then at the
base server. (For instructions on setting up trusted
server alarming, see the Help topic, Configuring a
trusted server, that is accessible within the Avaya
Web Messaging Administrator screens). Enter the
previously established logon and password at this
base server page.

Click Submit to add the message server to the
server list.

Repeat Step 5 through Step 8 for each message
server to be configured.

In the Server list you created, select one radio
button next to a message server and click Retrieve
Names Directory to begin retrieving its Names
Directory.

Depending on the size of the Names Directory, the
retrieval process could take considerable time,
especially for an INTUITY AUDIX message server.
For example, a Names Directory on an INTUITY
AUDIX with 30,000 names could take 30 minutes or
more to download. For INTUITY AUDIX message
servers only, a pop-up screen appears that indicates
that the directory retrieval is time-consuming and
should be carried out at times of non-peak traffic;
click OK.

The Names Directory Retrieval column displays “In
Progress.” You can initiate retrieval of only one
Names Directory at a time, but once the retrieval is
in progress, you can select another message server
on the list and initiate its Names Directory retrieval,
and so on.

Refresh the page by using the browser control to
view the current status. When the download is
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complete, “In Progress” changes to the time of the
download.

Repeat this step to retrieve the names directories
for all configured message servers.

Configure You can work with the system administrator to configure
Options and the following parameters on the Options and Settings page
Settings now or you can proceed directly to the section Run Install
Verify Tool on page 35 and configure the parameters later:
Options and Settings Default
Web Server timeout 20 minutes
Corporate logo to be displayed Avaya logo

Edit the Web Link Control

Voice Player

downloaded by user; enabled

Message of the Day

Wireless access IP

Port number

Use SSL for Web Clipping check box

disabled (check box cleared)

IMAP4 Server check box

enabled (check box selected)

Backup and Restore buttons

Further information about these parameters follows.
Web Server Timeout

When Avaya Web Messaging users do not actively use
Avaya Web Messaging for the number of minutes
configured here, their sessions are dropped and they are
redirected to the login page.

In the Web Server Timeout box, enter the number of
minutes to wait before timing out.
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Corporate Logo

The user’s Avaya Web Messaging logon page can display
either the Avaya logo or a customized logo. To specify the
corporate logo:

1. Check the correct Corporate Logo button to use,
either Avaya or Custom.

2. Click Submit.

3. If you selected Custom, navigate to the Avaya Web
Messaging directory:

<drive>:\<program
directory>\webmsg\images\

Replace the existing CustomLogo.gif file with a new
CustomLogo.gif file that contains the graphics the
customer wants to be displayed. For best
appearance on the Web page, it is recommended
that the new logo be approximately the same size
as the logo being replaced.

Edit the Web Link Control

This feature is optional, and it can be used to provide end
users a link to a customer’s Web-based e-mail or to any
important Web location that the customer designates.

Enter the URL in the Web Link URL location box.

The icon to access this URL appears on each user’s main
Avaya Web Messaging page. When this icon is selected,
the configured URL destination is launched.

Voice Player

Each user who wants to use the Avaya Voice Player must
download it.

Message of the Day

The system administrator creates this message that users
see when they log in.

Wireless Access IP

This IP address is heeded for any wireless device that uses
Web clipping. It is the IP address for external access from
the Internet to the UCC base server inside the corporate
network.
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Run Install Verify
Tool

Port Number

If the standard port 80 is not to be used, provide the port
number for Web clipping here.

Use SSL for Web Clipping check box

Ask the system administrator if SSL is to be used for Web
clipping.

IMAP4 Server check box

Select this check box if the customer wants to allow users
to have integrated voicemail and e-mail access as opposed
to voicemail access only.

Backup and Restore buttons

From the Options and Setting page, you can back up the
information you have configured and you can restore it.

To back up the configured information:
1. Click Backup.

You are asked whether to proceed with the backup
since doing so removes the information from your
previous backup.

2. Click OK.
To restore the configured information:
m Click Restore.

You are asked whether to proceed with the restore
operation because restoring overwrites your current
settings.

Important: If a backup file does not exist and you click
Restore, the information is restored to its default values.

The Install Verify Tool (IVY) is used to verify and diagnose
Avaya Web Messaging installation. The Install Verification
page from the Administration and Maintenance pages
shows the same IVY report as the application, but without
as many features. The IVY application, which you can
access from the Avaya Web Messaging Tools program
group, gives you more flexibility and features and a better
graphical interface. You can save and print the report,
change the filter for viewing data, and create different
baselines for comparisons.
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When you open IVY, it starts automatically, and the Install
Verify Window appears. Each Avaya Web Messaging file is
checked against the database. The status bar displays
each file name as it is being checked. When the check is
complete, the window displays a row of tabs. If the
selected tab does not show any errors or warnings, the
fields are empty.

The default is to create a report that shows only the errors
and warnings. You can change the information that is
viewed by clicking the stoplights on the toolbar. Red shows
only errors, yellow is the default that shows both errors
and warnings, and green shows all files.

The categories were created so that similar files can be
grouped together. Click a tab to display its information.

Establish a baseline report:

1. In Windows 2000, select Start > Programs >
Avaya Web Messaging Tools > Install Verify
Test - Ivy.

2. Click each tab in the Ivy window and check that
there are no errors (shown in red).

3. From the Tools menu, click Make Baseline.

4. Specify saving the file to the default folder and click
Save.

5. In the Select Output dialog box, select the All
Entries radio button and click OK.

6. After reading the following information about IVY
reports, when you are ready to close IVY, select File
> Exit.

Each file is checked for file name, location, size, date and
version, and Windows registry entry. Errors appear against
a red background, and warnings against a yellow
background. The information contained in the IVY
database is displayed on the first line for each file, and the
information found on the Web server is displayed on the
second line. Only information that is different between
these two databases is displayed. A blank column on the
second line indicates that the information matches.

You can create a baseline of the IVY report either from the
Tools menu or from the magnifying glass icon on the tool
bar. A baseline file contains information about the IVY
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Restart Tomcat

Add a User to
Avaya Web
Messaging

database and system differences at the time the baseline
was created.

When you review a report, you might notice some
differences that do not represent an error or warning that
needs to be addressed. For example, a newer version of a
system file present on the server is usually not replaced
with an older version, but the difference is displayed in the
IVY report. When you set the baseline, you can exclude
the differences from future IVY reports.

The baseline file is not used automatically when IVY
creates a report. To view the differences between an IVY
report and the baseline, from the Tools menu, click
Compare to Baseline. A new report is displayed that
shows only the errors and warnings that are not in the
Baseline file.

Note: Errors are logged to the NT event log. For INTUITY
AUDIX message servers, errors can also trigger INTUITY alarms.
When you create a baseline, any errors that exist at the time the
baseline is created are not viewed as new errors. Thus, they are
not logged to the NT event log and they do not trigger an
INTUITY alarm.

You can save and print the IVY reports. The file is a plain
ASCII file that can be sent with e-mail. These reports are
useful for describing problems to technical support
personnel.

Restart Tomcat (this ends all active user sessions, but
there normally would not be any sessions at this point):

1. In Windows 2000, select Start > Settings >
Control Panel > Administrative Tools >
Services.

2. Select Tomcat.

3. From the Action menu, click Restart.

Add a user to Avaya Web Messaging as described in the
UCC Administration Guide. Log into UCC as that user and
verify that Avaya Web Messaging works correctly.

If you did not install Avaya Web Collaboration, installation
and testing of the UCC base server are complete; in this
case, read the topic titled Installation of the Advanced
Speech Access Server on page 39.
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Verify the Avaya Web Collaboration Installation

To verify the Avaya Web Collaboration installation:

1.

On each PBX that UCC uses, set up users for their
primary and AWOH extensions.

In Windows 2000, select Start > Programs >
Avaya UCC Administration and click the UCC
User link.

Note: If the browser cannot run the required Java applet, it
offers to download the JRE plug-in from the Sun Microsystems
Web site. If you are unable or not allowed to download the latest
JRE plug-in from Sun, click the J2RE (plugin) link to install the
plug-in (it was previously copied from the UCC Release 1.0 CD
to the base server).

3.

Log on with cn=Directory Manager and the
password you established for the iPlanet Directory
Manager and Avaya Web Collaboration
administration (item 13 of Worksheets Base Server
Data on page 43).

For each switch (PBX) UCC uses, administer the
Avaya Web Collaboration dial plan. Consider the
unique dial plan of each PBX. See the
Administrator’s Guide and obtain assistance from
the PBX technician or the customer.

Add a user to Avaya Web Collaboration as described
in the UCC Administration Guide.

From the Web Collaboration Administrator’'s home
page, click the Server Options button and then
click the Clear Cache and Refresh Tserver
buttons.

Log in as a user and place a call to verify that Avaya
Web Collaboration works.
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Installation of the Advanced Speech Access

Server

The UCC Advanced Speech Access (ASA) server is an
optional separate server with its own software CDs and
installation guide. If the customer has ordered ASA, you
can install the ASA software on the speech server now if
you have not done so already.

Addition of Avaya Web Messaging or Avaya
Web Collaboration to the Base Server

If only Avaya Web Messaging or Avaya Web Collaboration
was installed initially, you can use the UCC Release 1.0 CD
to add the other software component.

Important: If you plan to install Avaya Web Collaboration, you
must shut down SNMP services and any associated server
monitoring agents now, before beginning this installation
procedure.

Important: If the customer plans to use Secure Socket Layer
(SSL) security for Avaya Web Collaboration, the SSL certificate
must have already installed on the base server.

Note: You might want to disable virus protection software
during the installation.

To add a software component:

1. Insert the UCC Release 1.0 CD and click INSTALL
UCC on the screen that automatically appears.

2. On the Program Maintenance screen, select the
Modify radio button.

3. On the Avaya Unified Communication Center —
InstallShield Wizard screen, click Next.

4. On the Setup screen, click the down arrow to the
left of the component you want to install and click
This feature will be installed on local hard
drive.

5. Proceed with the desired installation as described in
the topic Avaya Web Messaging on page 18 for
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Avaya Web Messaging installation, or the topics
iPlanet Directory Server on page 19 and Avaya Web
Collaboration on page 22 for iPlanet and Avaya Web
Collaboration installation.

6. As a basic verification of installation, access the
UCC administrator’s Web page and then launch the
administration Web page for the component you
just installed. If you cannot access one or more of
these Web pages, make sure that the Tomcat
service and the World Wide Web Publishing Service
are running (right click My Computer, click
Manage, expand Services and Applications, and
click Services).

7. Depending on which component you just installed,
complete the verification procedures in the topic
Verify the Avaya Web Messaging Installation on
page 29 or the topic Verify the Avaya Web
Collaboration Installation on page 38.

Addition of a PBX for Use with UCC

For each PBX to be used by UCC after UCC has been
installed, you need to configure the new PBX as described
in CVCT documentation and the “Add a Switch (PBX)”
section of the UCC Administrator’s Guide. You need to
administer the Avaya Web Collaboration dial plan. See the
following topics for important information about
configurations using multiple PBXs:

UCC Base Server Hardware Prerequisites on page 4

CVCT Prerequisites Unique to Avaya Web Collaboration on
page 9

PBX Prerequisites Unigue to Avaya Web Collaboration on
page 10

PBX Prerequisites on page 11

Verify the Avaya Web Collaboration Installation on page 38
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Removal of UCC Base Server Software

Components

Removing UCC

You can remove (uninstall) all of UCC or only Avaya Web
Collaboration or only Avaya Web Messaging. Select the
desired subtopic, Removing UCC or Removing Only Avaya
Web Messaging or Only Avaya Web Collaboration.

To remove all UCC software from the base server:

1. In Windows 2000, select Start > Settings >
Control Panel > Add/Remove Programs.

Caution: To remove UCC in its entirety, do not
individually select Avaya Web Collaboration or Avaya Web
Messaging from the software list for removal. If you do,
UCC cannot be uninstalled.

2. Select Avaya Unified Communication Center.

3. Select the Remove button.

Removing Only Avaya Web Messaging or Only Avaya Web

Collaboration

You can uninstall one of the components Avaya Web
Messaging or Avaya Web Collaboration, leaving the JRE,
Tomcat, and the UCC license manager installed.

Note: When you uninstall one UCC Release 1.0 software
component, Avaya Web Messaging or Avaya Web Collaboration,
you can later reinstall only the same version of that component
(by using the UCC Release 1.0 CD).

To uninstall Avaya Web Messaging or Avaya Web
Collaboration:

1. In Windows 2000, select Start > Settings >
Control Panel > Add/Remove Programs.

Caution: Do not individually select Avaya Web
Collaboration or Avaya Web Messaging from the software
list for removal. If you do, UCC Release 1.0 as a whole
cannot be uninstalled at a later time.

2. Select Avaya Unified Communication Center.
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3.
4.

Select the Change button.

On the Avaya Unified Communication Center —
InstallShield Wizard (Welcome) screen, click Next.

On the Avaya Unified Communication Center —
InstallShield Wizard (Setup) screen, click the down
arrow to the left of the component you want to
remove and click X This feature will not be
installed.

A red X appears beside that component to indicate
that it will be uninstalled.

Note: Uninstalling Avaya Web Collaboration also uninstalls
iPlanet Directory Server software, which requires you to enter
the administrative login and password noted in item 12 of
Worksheets Base Server Data on page 43.

6.
7.

Click Next.

Proceed with the UCC software component removal
as you would to remove any program through
Windows.
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This topic includes worksheets to consolidate the
information that needs to be recorded at the customer site
prior to installation as described in the topic Prerequisites
on page 4 and during installation as described in the topic
Installation on page 13.

Base Server Data

Data to Obtain Before Installing UCC

1.

Windows 2000 Server administrative account
number and password (writing them here is
optional):

(Static) IP Address of NIC for corporate LAN:

Preferred DNS server address of NIC for corporate
LAN:

Host name (full computer name and domain):

Primary DNS suffix of this computer:

MAC (physical) address:
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10.

11.

Default gateway’s IP address:

Fully qualified domain alias name, if it is to be used:

If Avaya Web Collaboration is being installed, the
administrative account login and password on the
base server used by CVCT (whether CVCT is
coresident with UCC or on its own T-server):

If Avaya Web Collaboration is being installed and if
the customer has an external LDAP directory, its:

m LDAP URL:

m  Popular Name:

m Search Base:

Directory path to SSL certificate, if used for Avaya
Web Collaboration:

Data to Obtain While Installing UCC

12.

13.

14.

15.

If Avaya Web Collaboration is being installed, for the
iPlanet Configuration Directory Administrator ID:
admin, the iPlanet Directory server administrator
password:

If Avaya Web Collaboration is being installed, for the
iPlanet Directory Manager DN: cn=Directory
Manager, the iPlanet Directory manager (and Avaya
Web Collaboration directory administrator)
password:

License Manager Host ID:

License Manager administrator password:

Release 1.1

585-313-161 44
Issue 2



Worksheets

PBX Data (Obtain Before Installing UCC)

Enter data in the following fields only if Avaya Web
Collaboration is being installed. Enter values for each PBX
if multiple PBXs are used with UCC.

16. Range of reserved AWOH numbers:

17. IP address of MAP-D board in DEFINITY or C-LAN
board in IP600 for use with Avaya Web
Collaboration:

18. Software release, for example, G3V8 load release
49:

CVCT Data (Obtain Before Installing UCC)

Data for CVCT on Its Own Separate T-Server

Enter data in the following fields only if Avaya Web
Collaboration is being installed and only if CVCT is installed
on its own T-server separate from the UCC base server
(see also item 9 in Base Server Data on page 43):

19. Host name of T-server (full computer name and
domain):

20. (Static) IP address of NIC in T-server for connection
to the PBX:

Data for CVCT Coresident with UCC on the Base Server

Enter data in the following field only if Avaya Web
Collaboration is being installed and only if CVCT is installed
coresident with UCC software on the base server (see also
items 4 and 9 in Base Server Data on page 43):

21. (Static) IP address of NIC in T-server for connection
to the PBX:
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Advanced Speech Access (ASA) Server Data

22. Fully qualified domain name:
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A

adjunct
A computer that communicates with DEFINITY ECS
through an ASAI interface.

Adjunct-Switch Application Interface (ASAI)
A protocol supported by DEFINITY Enterprise Communi-
cation Server (ECS) that extends telephony features to
adjuncts.

Administration Without Hardware (AWOH)
In Avaya Web Collaboration, extensions that must be
administered in the Telephony and in the switch (PBX)
Services database to allow remote access. Also referred
to as softphone extensions or exports.

Advanced Speech Access
A Unified Communication Center application that allows
people to use their voices to interact with and access
their messages, tasks, and appointments. Advanced
Speech Access also permits users to manage their
phone calls and conferences.

Avaya Web Collaboration
A Unified Communication Center application that pro-
vides remote access to the voice and data capabilities
of your DEFINITY Enterprise Communication Server
(ECS).

Avaya Web Messaging
A Unified Communication Center application that pro-
vides a graphical user interface that allows users to
view, manage, and manipulate the contents of their
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voicemail, e-mail, and fax messages, by using a
browser.

AWOH
See Administration Without Hardware.

C

CentreVu® Computer Telephony (CV-CT)
Avaya's open, standards-based, API-neutral CTI server
software. CentreVu Computer Telephony is the underly-
ing CTI server software that integrates voice and data
between customers’ communications systems and their
business application environment.

Internet Information Server (1IS)
Microsoft Web server software that enables access to
UCC functionality through intranet web navigation.

D

DEFINITY Anywhere
The predecessor to Avaya Web Collaboration.

EC-500 Extension to Cellular
An Avaya Web Collaboration feature, formerly known as
DEFINITY Global Cellular Solution. When this feature is
administered for users, it allows a cellular phone to be
treated as a local extension to the DEFINITY PBX. The
cellular phone can use the same features and capabili-
ties for incoming calls as the office phone. When the
office phone rings, the administered cellular phone also
rings.

L

License File
A file that enables client usage of UCC for a specified
number of users.

P

Personal Digital Assistant (PDA)
A small consumer electronics device that performs spe-
cific tasks and, in some instances, connects to the
Internet or is combined with a cell phone.

S

Services Monitor
An Avaya Web Collaboration feature that includes an
error counter and detects when the Avaya Web Collabo-
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ration service is interrupted. If service is interrupted,
the Services Monitor will initiate a server restart in 20
seconds.

U

Unified Communication Center (UCC)
A suite of Avaya applications that can include any or all
of these applications: Advanced Speech Access, Avaya
Web Collaboration, and Avaya Web Messaging.

\'}

Voice Player
Plug-in software that enables messages to be played
and recorded through a computer equipped with a
sound card and microphone. The voice player is distrib-
uted by Avaya Inc.

W

www.messenger
The predecessor to Avaya Web Messaging.
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